## Legal Information

**Book Name:** AdminStudio 2021 Release Notes  
**Part Number:** ADM-2021-RN00  
**Product Release Date:** April 2021

### Copyright Notice

Copyright © 2021 Flexera  
This publication contains proprietary and confidential information and creative works owned by Flexera and its licensors, if any. Any use, copying, publication, distribution, display, modification, or transmission of such publication in whole or in part in any form or by any means without the prior express written permission of Flexera is strictly prohibited. Except where expressly provided by Flexera in writing, possession of this publication shall not be construed to confer any license or rights under any Flexera intellectual property rights, whether by estoppel, implication, or otherwise. All copies of the technology and related information, if allowed by Flexera, must display this notice of copyright and ownership in full.

### Intellectual Property

For a list of trademarks and patents that are owned by Flexera, see [https://www.flexera.com/producer/company/about/intellectual-property/](https://www.flexera.com/producer/company/about/intellectual-property/). All other brand and product names mentioned in Flexera products, product documentation, and marketing materials are the trademarks and registered trademarks of their respective owners.

### Restricted Rights Legend

The Software is commercial computer software. If the user or licensee of the Software is an agency, department, or other entity of the United States Government, the use, duplication, reproduction, release, modification, disclosure, or transfer of the Software, or any related documentation of any kind, including technical data and manuals, is restricted by a license agreement or by the terms of this Agreement in accordance with Federal Acquisition Regulation 12.212 for civilian purposes and Defense Federal Acquisition Regulation Supplement 227.7202 for military purposes. The Software was developed fully at private expense. All other use is prohibited.
Contents

AdminStudio 2021 Evaluation Guide ................................................................. 5

Getting Started .............................................................................................. 6
  About Evaluating AdminStudio ..................................................................... 6
  Purpose of Evaluation Guide ......................................................................... 7
  Organization of Evaluation Guide ................................................................ 9
  Evaluation Guide Data Files ........................................................................ 11

New Features .................................................................................................. 12
  Package Feed Module - Customization Wizards .......................................... 12
  Package Backlog Management ...................................................................... 12
  Documented REST APIs ............................................................................. 13
  MSIX App Attach ......................................................................................... 13
  MSIX Editor Enhancements .......................................................................... 13
    Importing of Registry Files ........................................................................ 13
    The Ability to Add a File or Folder in the Destination Details View .......... 14
    Support for the Use of Certificate Store to Digital Signing MSIX Package .. 14
    Display of the Path and File Name in the Windows Title bar .................... 14
    Providing of Log File Details in the Output Window ................................. 15
  Support for ConfigMgr 2010 ....................................................................... 15
  Support for Windows Server 2019 ............................................................... 16
  InstallShield 2020 R3 ................................................................................... 21

Setting Up AdminStudio Infrastructure .......................................................... 22
  Creating an Application Catalog ................................................................... 22
  Configuring a Virtual Machine ..................................................................... 23
  Setting E-Mail Notification Settings ............................................................. 26
  Entering Server/Database Connection Settings .......................................... 27

Migrating to Windows Installer ........................................................................ 28
  Repackaging a Sample Package ................................................................... 29
  Importing Packages into the Application Catalog ....................................... 31
  Testing a Repackaged Application and Resolving Issues ............................ 33
## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Distributing a Repackaged Application</td>
<td>36</td>
</tr>
<tr>
<td><strong>Migrating to Application Virtualization</strong></td>
<td>37</td>
</tr>
<tr>
<td>Identifying Packages to Virtualize</td>
<td>38</td>
</tr>
<tr>
<td>Converting to Virtual Formats</td>
<td>40</td>
</tr>
<tr>
<td>Testing and Distributing Converted Packages</td>
<td>42</td>
</tr>
<tr>
<td><strong>Testing for Application Compatibility</strong></td>
<td>43</td>
</tr>
<tr>
<td>Importing Packages, Web Applications, and Mobile Apps</td>
<td>44</td>
</tr>
<tr>
<td>Selecting Tests to Run and Setting Default Fix Option</td>
<td>45</td>
</tr>
<tr>
<td>Performing Testing and Viewing Results</td>
<td>46</td>
</tr>
</tbody>
</table>

In this procedure, you will test packages and web applications for operating system and browser compatibility, view test results, and automatically fix issues.
AdminStudio 2021 Evaluation Guide

AdminStudio makes short work of application deployment chores such as updates, new releases, new applications, and Windows 10 migrations. More than a packaging tool, AdminStudio arms your IT team with a complete application readiness solution, enabling you to identify and mitigate issues before pulling the deployment trigger. No more surprises.

With AdminStudio, you can:

- Improve service quality and streamline service delivery
- Decrease risk and embrace new technologies faster
- Eliminate mobile application security and compatibility concerns
- Reliably prepare and deploy application virtualization formats
- Integrate seamlessly with leading software deployment systems
- Simplify and unify application management with standardized processes
- Boost efficiency with a central application repository
- Identify application packaging issues in minutes instead of days

You can use this Evaluation Guide to quickly learn how to use AdminStudio to prepare Windows Installer, virtual applications, web applications, macOS desktop applications, and mobile applications for deployment. This Evaluation Guide is organized into the following sections:

Table 1 • AdminStudio 2021 Evaluation Guide

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Getting Started</strong></td>
<td>Explains what is included in this Evaluation Guide and how to get started.</td>
</tr>
<tr>
<td><strong>New Features</strong></td>
<td>Provides an overview of the new features in AdminStudio 2021.</td>
</tr>
</tbody>
</table>
Getting Started

This section explains what is included in this Evaluation Guide and how to get started:

- About Evaluating AdminStudio
- Purpose of Evaluation Guide
- Organization of Evaluation Guide
- Evaluation Guide Data Files

About Evaluating AdminStudio

You can choose to evaluate AdminStudio for 21 days. By clicking Continue to Evaluate AdminStudio dialog box that opens when you launch AdminStudio, you can begin evaluating the AdminStudio Enterprise Edition client tools.

Information about evaluating the AdminStudio client tools includes the following topics:

- AdminStudio Client Tools Evaluation Restrictions
- Evaluating AdminStudio’s Microsoft App-V Support
- Evaluating the Automated Application Converter “Multiple Application” Option
AdminStudio Client Tools Evaluation Restrictions

When you run AdminStudio in trial/evaluation mode, all of its features are fully available, with the following restrictions:

- **Can create only one Application Catalog**—You are permitted to create only one Application Catalog, and it must be named AdminStudio Evaluation Catalog.
- **Ten package import limit**—Only 10 total packages (of one or more deployment types) can be imported into the Application Catalog.
- **Package deletion not permitted**—After you import a package into the Application Catalog, you are not permitted to delete it.
- **AdminStudio Platform API support is disabled**—All platform support is disabled.

Evaluating AdminStudio’s Microsoft App-V Support

While evaluating the AdminStudio Enterprise Edition client tools, you will be able to convert a Windows Installer package to an App-V application using the Automated Application Converter, Conversion Wizard, Repackager, and the InstallShield App-V Assistant. However, an App-V application built using an evaluation version of AdminStudio will display the following message every time it is launched:

![Figure 1: Evaluation Version Message](image)

After activating AdminStudio, you will be able to remove this message by rebuilding the App-V application.

Evaluating the Automated Application Converter “Multiple Application” Option

The Multiple Application option of Automated Application Converter is only available when you purchase AdminStudio Enterprise Edition.

Note • With AdminStudio Standard or Professional Editions, you will only be able to convert one package at a time, using one virtual machine.

When using an evaluation version of AdminStudio, you will be able to use Automated Application Converter to convert a directory full of Windows Installer packages into individual virtual packages, but the conversion will be limited to three packages per run, using only one virtual machine. Therefore, only the first three packages that Automated Application Converter encounters will be converted to virtual applications.

Purpose of Evaluation Guide

The purpose of this Evaluation Guide is to help system administrators and other reviewers learn how to quickly get started using AdminStudio to prepare Windows Installer and virtual applications for deployment. By performing the exercises in this Evaluation Guide using the provided data files, you will learn how to:

- Create an Application Catalog
- Repackage a sample package
• Import packages into the Application Catalog
• Test Windows Installer packages, App-V packages, and web applications
• Configure a virtual machine for use in automated repackaging
• Convert Windows Installer packages to virtual applications
• Distribute Windows Installer and App-V packages
• Perform operating system compatibility and browser compatibility testing
## Organization of Evaluation Guide

This Evaluation Guide provides exercises that guide you through performing the following key procedures:

### Table 2 • Evaluation Exercises

<table>
<thead>
<tr>
<th>Procedure</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>**Setting Up AdminStudio</td>
<td>In these set of exercises, you will perform the one-time setup tasks that are necessary to get started using AdminStudio:</td>
</tr>
<tr>
<td><strong>Infrastrucure</strong></td>
<td>- Creating an Application Catalog</td>
</tr>
<tr>
<td></td>
<td>- Configuring a Virtual Machine</td>
</tr>
<tr>
<td></td>
<td>- Setting E-Mail Notification Settings</td>
</tr>
<tr>
<td></td>
<td>- Entering Server/Database Connection Settings</td>
</tr>
<tr>
<td><strong>Migrating to Windows Installer</strong></td>
<td>In this set of exercises, you will migrate a sample setup (such as an .exe file) to a deployable Windows Installer package (.msi):</td>
</tr>
<tr>
<td></td>
<td>- Repackaging a Sample Package</td>
</tr>
<tr>
<td></td>
<td>- Importing Packages into the Application Catalog</td>
</tr>
<tr>
<td></td>
<td>- Testing a Repackaged Application and Resolving Issues</td>
</tr>
<tr>
<td></td>
<td>- Distributing a Repackaged Application</td>
</tr>
<tr>
<td><strong>Migrating to Application Virtualization</strong></td>
<td>In this set of exercises, you will migrate a set of applications into virtual applications that are ready for deployment:</td>
</tr>
<tr>
<td></td>
<td>- Identifying Packages to Virtualize</td>
</tr>
<tr>
<td></td>
<td>- Converting to Virtual Formats</td>
</tr>
<tr>
<td></td>
<td>- Testing and Distributing Converted Packages</td>
</tr>
<tr>
<td><strong>Testing for Application Compatibility</strong></td>
<td>In this set of exercises, you will test Windows Installer packages for application readiness on the latest versions of Microsoft Windows and Windows Server. You will also test web applications for compatibility with Internet Explorer 11 and Microsoft Edge.</td>
</tr>
<tr>
<td></td>
<td>- Importing Packages, Web Applications, and Mobile Apps</td>
</tr>
<tr>
<td></td>
<td>- Selecting Tests to Run and Setting Default Fix Option</td>
</tr>
<tr>
<td></td>
<td>- Performing Testing and Viewing Results</td>
</tr>
</tbody>
</table>
These four main procedures are also featured on AdminStudio’s Start Page.

Figure 2: AdminStudio Start Page
Each subtab of the Start Page includes a flowchart that lists the steps in each procedure. For example, the following flowchart is displayed on the **Migrate to Windows Installer** tab:

![Flowchart](image.png)

**Figure 3:** Migrate to Windows Installer Tab of AdminStudio Start Page

### Evaluation Guide Data Files

To perform the exercises in the AdminStudio Evaluation Guide, you will be using the sample data that is provided in the ASEvalGuideDataFiles.zip file. These data files are organized into the following directories:

- `SampleApplicationSetup`
- `SampleApplicationSource`
- `SampleApplicationTarget`
- `SampleKit`

**Figure 4:** Directory Structure of AdminStudio Evaluation Guide Data Files

These data files demonstrate the recommended organizational structure that you should use when you want to import a directory of packages into the Application Catalog:

- **One root directory**—Organize the packages you want to import in one root directory (ASEvalGuideDataFiles in this example).

- **Each application in a subdirectory**—Each application should be stored in its own first level subdirectory (such as SampleKit or SampleApplicationTarget).

- **Each deployment type in a sub-subdirectory**—Each deployment type should be stored in its own sub-subdirectory (AppV, MSI, etc.) of the application directory.

Unzip this data file and place its contents in a location accessible to your installation of AdminStudio, such as:

C:\ASEvalGuideDataFiles
New Features

This section lists the new features that are included in AdminStudio:

- **Package Feed Module - Customization Wizards**
- **Package Backlog Management**
- **Documented REST APIs**
- **MSIX App Attach**
- **MSIX Editor Enhancements**
- **Support for ConfigMgr 2010**
- **Support for Windows Server 2019**
- **InstallShield 2020 R3**

**Package Feed Module - Customization Wizards**

In AdminStudio 2021, the Package Feed Module introduces a new custom installation capability which provides application specific options for customizing installation options which provides a Windows Installer Transform (MST) file.

For more information, see [Importing an Application Using the Package Feed Module](#).

**Package Backlog Management**

In AdminStudio 2021, you can now manage a simple backlog of packaging requests directly within AdminStudio. Set priorities, sort and filter. The list may be populated by importing a CSV file, via a new PowerShell Cmdlet and even by a newly documented API to facilitate integration with any existing process of workflows.
Documented REST APIs

AdminStudio can now support REST APIs to achieve various functionalities in the product. This API can be called by an external system to integrate with the new backlog capability, as well as to perform a wide range of other actions and issue requests.

AdminStudio continues to offer its PowerShell support via custom cmdlets. A new command (New-ASPackageRequest) is offered to provide the same capability for adding items to the backlog via PowerShell script.

For more details, see AdminStudio REST APIs.

MSIX App Attach

In support of Windows Virtual Desktop (WVD) environments, you can create VHD or VHDX images in support of App Attach when working with MSIX packages. MSIX App Attach allows you to dynamically attach applications to WVD sessions without the need for a traditional installation process, saving time, and reducing complexity.

For more details on availability of Microsoft’s App Attach feature, see this article.

MSIX Editor Enhancements

In AdminStudio 2021, the below MSIX Editor improvements are now available:

- Importing of Registry Files
- The Ability to Add a File or Folder in the Destination Details View
- Support for the Use of Certificate Store to Digital Signing MSIX Package
- Display of the Path and File Name in the Windows Title bar
- Providing of Log File Details in the Output Window

Importing of Registry Files

Under Registry view, you can import the registry files for the selected MSIX package. Just right click on the Package Content node of the registry view and choose Import REG File.
The Ability to Add a File or Folder in the Destination Details View

Under Files and Folders view, in the Package Content destination folder you can add a file or folder as appropriate.

Support for the Use of Certificate Store to Digital Signing MSIX Package

In AdminStudio 2021, you can now choose certificates for signing MSIX packages in the MSIX Editor from your local Certificate Store.

Display of the Path and File Name in the Windows Title bar

In the windows title bar of the MSIX Editor, you can now see the File Name and Path to easily identify which MSIX package is open.
Providing of Log File Details in the Output Window

In the Output window of the MSIX Editor, you can now see the hyperlink saying \textbf{Click here} to open a log file. Clicking on the link will launch the log file in a new window to review its contents more easily.

Support for ConfigMgr 2010

In AdminStudio 2021, you can distribute the following deployment types to the distribution system ConfigMgr 2006 and 2010.

- Microsoft Windows Installer Package (.msi)
- Microsoft App-V Virtual Package (.sft, .appv)
- Apple iOS (local and public store)
- Google Android (local and public store)
- Microsoft UWP app packages (.appx)
- Installation Package (.exe)
New Features

- PowerShell wrapped packages (.ps1)
- Microsoft MSIX Package (.msix)

Support for Windows Server 2019

In AdminStudio 2021, you can run application’s compatibility testing against the new Windows Server 2019 version for the applications in your catalog.

The new Windows Server 2019 version will appear in the following:
- Test Selection Wizard
- Analyze Tab
- Reports Tab

Test Selection Wizard

In AdminStudio 2021, you can select Windows Server 2019 build in the Test selection wizard to test the operating system compatibility.

Analyze Tab

In AdminStudio 2021, you can view the operating system compatibility details for Windows Server 2019 in the following places:

Group Chart View

In AdminStudio 2021, you can select Windows Server 2019 in the operating system compatibility chart view.
Summary View

In AdminStudio 2021, you can view the package summary for Windows Server 2019 in the operating system compatibility tab.

Detail View

In AdminStudio 2021, you can view the result summary for Windows Server 2019 in the operating system compatibility tab.
Reports Tab

In AdminStudio 2021, you can see the operating system compatibility for Windows Server 2019 in the following reports:

**Application Readiness Dashboard Report**

In AdminStudio 2021, you can see no change in Application Readiness Dashboard report.
Operating System Compatibility Group Dashboard Report

In AdminStudio 2021, you can see the overall status of operating system application compatibility testing for group applications in Operating System Compatibility Group Dashboard Report.

Overall Package Testing Results Report

In AdminStudio 2021, you can see the overall test results for Windows installer packages for Windows Server 2019 in Overall Package Testing Results Report.

Windows Desktop OS Compatibility Dashboard Report

In AdminStudio 2021, you can see the compatibility issues in pie chart format for Windows Server 2019 in Windows Desktop OS Compatibility Dashboard Report.
Test Impact Report

In AdminStudio 2021, you can see the reports of three OS compatibility tests for Windows Server 2019 in Operating System Compatibility by Test Impact Report.

Test Suppression Report

In AdminStudio 2021, you can see the Windows 10 20H2 64-bit, Windows Server 2016, and Windows Server 2019 for three tests that have been suppressed in Operating System Compatibility by Test Suppression Report.

Snapshot Analysis Report

In AdminStudio 2021, you can see the compatibility testing error and warning for Windows Server 2019 in Operating System Compatibility Snapshot Analysis Report.
InstallShield 2020 R3

For more information on InstallShield 2020 R3 Release Notes, see the InstallShield 2020 Release Notes.
Setting Up AdminStudio Infrastructure

The flowchart on the **Set Up Infrastructure** tab of the AdminStudio Start page lists the steps you need to perform before you can get started using AdminStudio.

**Figure 5:** Set Up Infrastructure Tab of AdminStudio Start Page

These are specific one-time set-up tasks that you need to perform prior to using AdminStudio. To set up AdminStudio infrastructure, perform the following exercises:

- Creating an Application Catalog
- Configuring a Virtual Machine
- Setting E-Mail Notification Settings
- Entering Server/Database Connection Settings

Creating an Application Catalog

With AdminStudio, you manage your applications and their deployment types in an Application Catalog database, which stores all package information, including test results. This enables you to perform enterprise level data checking. You can share your Application Catalog between multiple AdminStudio users.

AdminStudio and many of its tools (such as Application Manager) require you to be connected to an Application Catalog, while others give you the option of working with packages on a local or network directory or from Microsoft System Center Configuration Manager Server.
In this exercise, you will create a new AdminStudio Application Catalog and set it as the default.

### Table 3 • Create/Connect to an Application Catalog

<table>
<thead>
<tr>
<th>#</th>
<th>Step</th>
<th>Instructions</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Create an Application Catalog</td>
<td>Open AdminStudio and create a new SQL Server Application Catalog database named AdminStudio Evaluation Catalog, as described in Creating New Application Catalogs Using the AdminStudio Interface.</td>
<td>AdminStudio is open and connected to a new Application Catalog named AdminStudio Evaluation Catalog.</td>
</tr>
</tbody>
</table>

**Note** • On the Select Software Repository Location panel of the Application Catalog Wizard, do NOT select the Enable Software Repository option.

### Configuring a Virtual Machine

Virtual machines are used by Automated Application Converter during automated repackaging (performed during conversion to virtual applications) and when testing applications.

You need to prepare each virtual machine that you are going to use with the Automated Application Converter to perform automated repackaging or testing by doing the following:

- **Run Virtual Machine Preparation setup**—On each virtual machine you are going to use with the Automated Application Converter, run the Virtual Machine Preparation setup, an application that will enable automatic login. You need to run this application one time on all of the virtual machines that you are going to use with the Automated Application Converter.

- **Create a snapshot**—After you have run the Virtual Machine Preparation setup on a virtual machine, you need to shut it down and create a snapshot named AutoRepack_Base. This enables the Automated Application Converter to revert the virtual image to a clean state after each repackaging run.

- **Install VMware VIX API (VMware only)**—In order for the Automated Application Converter to perform automated repackaging, it needs to communicate with the virtualization technology that you are using. If you are using VMware virtualization technology (VMware ESX or ESXi Server or a local VMware Workstation 6.5 or later), you need to have the VMware VIX API installed on the same machine as the Automated Application Converter.
In this exercise, you will configure a virtual machine for use with Automated Application Converter.

### Table 4 • Configure Virtual Machines

<table>
<thead>
<tr>
<th>#</th>
<th>Step</th>
<th>Instructions</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Run Virtual Machine Preparation setup to enable auto login</td>
<td>On a Microsoft Hyper-V Server image, VMware ESX/ ESXi Server image, or VMware Workstation (6.5+) image, run the virtual machine preparation setup.</td>
<td>When you restart the virtual machine image, you are automatically logged in and GuestAgent.exe is launched.</td>
</tr>
</tbody>
</table>

Note • For instructions, see Preparing Your Virtual Machines for Use With the Automated Application Converter.

| 2. | Create a snapshot for repackaging | On the prepared virtual image, create a clean snapshot named AutoRepack_Base. | A clean snapshot named AutoRepack_Base exists on the virtual machine. |

Note • For instructions, see Taking a Snapshot in Preparing Your Virtual Machines for Use With the Automated Application Converter.
3. **Install VMware VIX**  
If you are using a VMware ESX/ESXi Server or VMware Workstation image, you need to install the VMware VIX API on the AdminStudio machine.

To install the VMware VIX API on the AdminStudio machine, do one of the following:

- Install VMware Workstation on the AdminStudio machine.
- Download and install the VMware VIX API on the AdminStudio machine. You can download the VMware VIX API from the following location:
  
  http://www.vmware.com/support/developer/vix-api

**Note** • For instructions, see *VMware VIX API Requirement*. 

---

**Table 4 • Configure Virtual Machines**

<table>
<thead>
<tr>
<th>#</th>
<th>Step</th>
<th>Instructions</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td><strong>Install VMware VIX</strong></td>
<td>If you are using a VMware ESX/ESXi Server or VMware Workstation image, you need to install the VMware VIX API on the AdminStudio machine.</td>
<td>The VMware VIX API is installed successfully.</td>
</tr>
</tbody>
</table>

To install the VMware VIX API on the AdminStudio machine, do one of the following:

- Install VMware Workstation on the AdminStudio machine.
- Download and install the VMware VIX API on the AdminStudio machine. You can download the VMware VIX API from the following location:
  
  http://www.vmware.com/support/developer/vix-api

**Note** • For instructions, see *VMware VIX API Requirement*. 

---

AdminStudio 2021 Release Notes   ADM-2021-RN00
Setting E-Mail Notification Settings

To enable AdminStudio to send you e-mail notifications during various processes, you need to configure your SMTP notification settings.

Currently, e-mail notifications are sent when soft time-outs are encountered while using Automated Application Converter to repackage an application on a virtual machine.

In this exercise, you will enter the SMTP settings for e-mail notifications. This enables AdminStudio to send notifications when a soft time out is encountered during repackaging on a virtual machine by Automated Application Converter.

Table 5 • Set E-Mail Notification Settings

<table>
<thead>
<tr>
<th>#</th>
<th>Step</th>
<th>Instructions</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Set SMTP Notification Settings</td>
<td>On the Notification Settings tab of the AdminStudio Options dialog box, enter your SMTP settings for e-mail notifications.</td>
<td>When you click Test on the Notifications Settings tab, a successful message opens.</td>
</tr>
</tbody>
</table>
Entering Server/Database Connection Settings

In AdminStudio 2021, you can define multiple named connections to System Center Configuration Manager, Citrix XenApp, Symantec Altiris Client Management Suite, Microsoft Server App-V, JAMF Casper Suite, and AirWatch distribution systems. This enables you to both have multiple connections easily available during import and distribution, and to refer to those connection settings by name in Platform API commands.

You need to specify at least one named connection to a distribution system in order for Application Manager to import packages, distribute applications, or report on application deployment status.

To enable AdminStudio to display data from your Microsoft ACT (Application Compatibility Toolkit) database in views and reports, you need to enter connection information for your Microsoft ACT database.

Table 6 • Enter Server Connection Settings

<table>
<thead>
<tr>
<th>#</th>
<th>Step</th>
<th>Instructions</th>
<th>Result</th>
</tr>
</thead>
</table>
| 1. | Enter System Center Configuration Manager connection settings | Open the Application Manager Options dialog box, and on the Distribution System tab, create a named connection to System Center 2012 Configuration Manager. | When you click Test on the Distribution System tab, the following message is displayed:  
Connection to ServerName Succeeded |

Note • For instructions, see Creating a New Distribution System Connection Setting

| 2. | Entering Microsoft ACT database connection settings | Open the Application Manager Options dialog box, and on the Microsoft ACT tab, enter Microsoft ACT database connection information. | When you click Test on the Microsoft ACT tab, a successful message opens: 
Connection to Microsoft ACT database successful |

Note • This is an optional step that you can perform if your organization has a Microsoft ACT database and you want to display that data in Application Manager.
Migrating to Windows Installer

The flowchart on the Migrate to Windows Installer tab of the AdminStudio Start page lists the steps you need to perform to migrate a sample setup (such as an .exe file) to a deployable Windows Installer package.

Figure 6: Migrate to Windows Installer Tab of AdminStudio Start Page

In this section, you will convert a sample setup named SampleApplicationSetup.exe to a Windows Installer Package, import it into the Application Catalog, test it for best practices, operating system compatibility, and application conflicts, and then prepare it for distribution using Distribution Wizard.

Important • It is preferable to repackage 32-bit applications on 32-bit operating systems. In this exercise, we will be repackaging a 32-bit application.

To migrate a sample application to a Windows Installer package, perform the following steps:

- Repackaging a Sample Package
- Importing Packages into the Application Catalog
- Testing a Repackaged Application and Resolving Issues
Repackaging a Sample Package

In this procedure, you will repackage a sample setup, perform some minor edits in Repackager, and then build a Windows Installer package.

Table 7 • Repackage a Sample Package

<table>
<thead>
<tr>
<th>#</th>
<th>Step</th>
<th>Instructions</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Select and repackage a sample package (.exe) to a Windows Installer Package (.msi)</td>
<td>Use Repackaging Wizard (Installation Monitoring method) to repackage the following sample setup: C:\ASEvalGuideDataFiles\SampleApplicationSetup\SampleApplicationSetup.exe</td>
<td>The captured data was converted into a Repackager project file (SampleApplication.irp) and opened in the Repackager interface.</td>
</tr>
<tr>
<td>2</td>
<td>Important • It is recommended that you repackage this sample package on a clean machine.</td>
<td>Save the captured data in the following directory: C:\Packages</td>
<td>Note • For instructions, see Repackaging Using the Installation Monitoring Method.</td>
</tr>
</tbody>
</table>

Important • It is recommended that you repackage this sample package on a clean machine.

Save the captured data in the following directory:

C:\Packages

Note • For instructions, see Repackaging Using the Installation Monitoring Method.
### Table 7 • Repackage a Sample Package

<table>
<thead>
<tr>
<th>#</th>
<th>Step</th>
<th>Instructions</th>
<th>Result</th>
</tr>
</thead>
</table>
| 3. | Edit package in Repackager and build Windows Installer package | To exclude files that are not part of the package, open the **Files and Folders** view, right-click on the **[WindowsVolume]** folder and select **Exclude All** from the context menu. Click **Save**. Note • For instructions, see **Excluding All Files in a Directory**. | The **[WindowsVolume]** folder is displayed in red to indicate that it is excluded: ![Folder](image)

**Note** • For instructions, see **Excluding All Files in a Directory**.

Open the **Repackaged Output** view and click **Build** to build a Windows Installer package. **Note** • For instructions, see **Building a Windows Installer Package**. The Repackager project file has been converted to a Windows Installer package, located in the following directory: C:\Packages\MSI_Package\SampleApplication.msi

Copy all of the files in the C:\Packages\MSI_Package directory (including the SampleApplication.msi file) to the following directory on the machine where AdminStudio is installed: C:\ASEvalGuideDataFiles\SampleApplicationSetup\ New Windows Installer package (and other associated files) are now in the same main directory as the other evaluation data files.
Importing Packages into the Application Catalog

In this procedure, you will import Windows Installer packages into the Application Catalog, including the one you created in Repackaging a Sample Package:

Table 8 • Import Into Application Catalog

<table>
<thead>
<tr>
<th>#</th>
<th>Step</th>
<th>Instructions</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.</td>
<td>Import Windows Installer package into Application Catalog</td>
<td>Before beginning import, open the Application Manager Options dialog box and clear the selection of the Automatically Execute Tests After Import option.</td>
<td>The packages are now listed in the Application Manager tree, each under its own Application node:</td>
</tr>
</tbody>
</table>

Next, use the Import Wizard to import all of the packages in the ASEvalGuideDataFiles directory.

- On the Source panel, select Folder of multiple applications.
- On the Package Type Selection panel, select the Microsoft Windows Installer package (.msi) option
- On the Package Folder Selection panel, select the C:\ASEvalGuideDataFiles directory.
- On the Select Applications panel, leave all of the applications selected.
- On the Destination Group panel, select the Applications folder in the tree. Do not select the Create subgroups based on source folder structure option.

Note • For instructions on how to import a directory of packages into the Application Catalog, see Importing a Folder of Multiple Packages.
Create a new group in the Application Manager tree named Engineering and move the Sample Application into that new group.

Note • For instructions, see Adding Groups and Organizing Applications in Application Manager.

Create another new group in the Application Manager tree named Marketing, and move the other three applications into that group.

The Application Manager tree should now be organized as follows:

<table>
<thead>
<tr>
<th>Applications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Engineering</td>
</tr>
<tr>
<td>Sample Application</td>
</tr>
<tr>
<td>Sample Application Source</td>
</tr>
<tr>
<td>Sample Application Target</td>
</tr>
<tr>
<td>Sample Kit</td>
</tr>
</tbody>
</table>

The Application Manager tree should now be organized as follows:

<table>
<thead>
<tr>
<th>Applications</th>
</tr>
</thead>
<tbody>
<tr>
<td>Engineering</td>
</tr>
<tr>
<td>Marketing</td>
</tr>
<tr>
<td>Sample Application Source</td>
</tr>
<tr>
<td>Sample Application Target</td>
</tr>
<tr>
<td>Sample Kit</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>#</th>
<th>Step</th>
<th>Instructions</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.</td>
<td>Import Windows Installer package into Application Catalog (Continued)</td>
<td>Create a new group in the Application Manager tree named Engineering and move the Sample Application into that new group.</td>
<td>The Application Manager tree should now be organized as follows:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>![Diagram of Application Manager tree with Engineering group and Sample Application]</td>
</tr>
<tr>
<td></td>
<td>Create another new group in the Application Manager tree named Marketing, and move the other three applications into that group.</td>
<td>The Application Manager tree should now be organized as follows:</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>![Diagram of Application Manager tree with Marketing group and other three applications]</td>
<td></td>
</tr>
</tbody>
</table>
Testing a Repackaged Application and Resolving Issues

In this procedure, you will test the Windows Installer packages you imported into the Application Catalog, and then distribute a package to a network location.

Table 9 • Test and Distribute Repackaged Applications

<table>
<thead>
<tr>
<th>#</th>
<th>Step</th>
<th>Instructions</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>Perform Windows Installer best practices and OS compatibility testing</td>
<td>To perform Windows Installer best practices and operating system compatibility testing on all of the packages in the Application Catalog, first select the Analyze tab in the Application Manager ribbon. Then, select the Applications group in the Application Manager tree, and click Execute Tests.</td>
<td></td>
</tr>
</tbody>
</table>

**Note** • For more information, see **Performing Compatibility and Best Practices Testing**.

When testing is finished, view the test results by selecting a Windows Installer package in the tree to open the Summary view on the Supportability Risks tab of the Analyze Deployment Type View, as shown below:

On Analyze tab views, groups, applications, and packages are assigned a test status in each test group using status icons. For packages, the status icon identifies that package's test status (as described in About Status Icons). For groups and applications, Application Manager considers all of the packages in that group or application, and displays the status icon for the package that has the status at the highest hierarchical level, as described in the Hierarchical Level of Status Icons section of the About Status Icons help topic.

**Note** • For more information, see Viewing Summary Test Results.
6. **Perform application conflict testing**

   Use the Conflict Wizard to detect conflicts between the following two packages:
   - **Source**: Sample Application Source
   - **Target**: Sample Application Target

   **Note** • For instructions, see *Testing for Conflicts Between Packages*.

7. **Review test results**

   When application conflict testing is finished, view the test results by selecting the Sample Application Source MSI package in the tree, and then clicking on **Windows Installer Conflicts** under Application Conflicts on the Supportability Risks tab of the Analyze Deployment Type View. Errors and warnings are listed. Click the plus sign next to a test name to view individual error/warning messages for that package:

   ![Windows Server 2016 Test Results](image)

   Next, click the suppress (ON/OFF) button next to the **Identical Merge Modules** error to suppress that test from test totals and from automatic resolution. The button toggles to the OFF position and the error icon turns to gray.

   **Note** • For more information, see the following topics:
   - Viewing Detailed Package Test Results
   - Viewing Application Conflicts Test Results
   - Filtering Test Results by Suppressing Errors/Warnings

---

**Table 9 • Test and Distribute Repackaged Applications**

<table>
<thead>
<tr>
<th>#</th>
<th>Step</th>
<th>Instructions</th>
</tr>
</thead>
<tbody>
<tr>
<td>6</td>
<td><strong>Perform application conflict testing</strong></td>
<td>Use the Conflict Wizard to detect conflicts between the following two packages:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Source</strong>: Sample Application Source</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <strong>Target</strong>: Sample Application Target</td>
</tr>
<tr>
<td>7</td>
<td><strong>Review test results</strong></td>
<td>When application conflict testing is finished, view the test results by selecting the Sample Application Source MSI package in the tree, and then clicking on <strong>Windows Installer Conflicts</strong> under Application Conflicts on the Supportability Risks tab of the Analyze Deployment Type View. Errors and warnings are listed. Click the plus sign next to a test name to view individual error/warning messages for that package:</td>
</tr>
<tr>
<td></td>
<td></td>
<td><img src="image" alt="Windows Server 2016 Test Results" /></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Next, click the suppress (ON/OFF) button next to the <strong>Identical Merge Modules</strong> error to suppress that test from test totals and from automatic resolution. The button toggles to the OFF position and the error icon turns to gray.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note</strong> • For more information, see the following topics:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Viewing Detailed Package Test Results</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Viewing Application Conflicts Test Results</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Filtering Test Results by Suppressing Errors/Warnings</td>
</tr>
</tbody>
</table>
8. Perform automatic issue resolution

Issues for which automatic fixes are available are identified by the Error With Fix or Warning With Fix icon:

![Error and Warning Icons]

To automatically resolve all issues for which automatic fixes are available, select the **Applications** group node in the tree and click **Resolve Issues** on the **Analyze** tab of the ribbon.

**Note** • For more information, see **Performing Automatic Issue Resolution**.

Issue resolution begins, progress messages appear in the Output window, and Application Manager performs the following tasks:

- **Reruns tests**—Application Manager reruns all of the selected tests to ensure that the issues that it is going to resolve still exist in the current version of the package and its associated transforms.
- **Creates transform files**—To resolve issues, Application Manager generates fix transform files.
- **Reimports packages**—Application Manager then automatically reimports each package and its fix transform files into the Application Catalog.

When issue resolution and reimporting is complete, look at the **Analyze Group View**, **Application View**, or **Deployment Type View** of the package, application, or group that you tested. You will see that the Error With Fix and Warning With Fix icons have been replaced with the status icon with the next highest level (as described in the **Hierarchical Level of Status Icons** section of the **About Status Icons** help topic) in that test category.

---

**Table 9 • Test and Distribute Repackaged Applications**

<table>
<thead>
<tr>
<th>#</th>
<th>Step</th>
<th>Instructions</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>8</td>
<td>Perform automatic issue resolution</td>
<td>Issues for which automatic fixes are available are identified by the Error With Fix or Warning With Fix icon:</td>
<td></td>
</tr>
</tbody>
</table>

To automatically resolve all issues for which automatic fixes are available, select the **Applications** group node in the tree and click **Resolve Issues** on the **Analyze** tab of the ribbon.

**Note** • For more information, see **Performing Automatic Issue Resolution**.

Issue resolution begins, progress messages appear in the Output window, and Application Manager performs the following tasks:

- **Reruns tests**—Application Manager reruns all of the selected tests to ensure that the issues that it is going to resolve still exist in the current version of the package and its associated transforms.
- **Creates transform files**—To resolve issues, Application Manager generates fix transform files.
- **Reimports packages**—Application Manager then automatically reimports each package and its fix transform files into the Application Catalog.

When issue resolution and reimporting is complete, look at the **Analyze Group View**, **Application View**, or **Deployment Type View** of the package, application, or group that you tested. You will see that the Error With Fix and Warning With Fix icons have been replaced with the status icon with the next highest level (as described in the **Hierarchical Level of Status Icons** section of the **About Status Icons** help topic) in that test category.
Distributing a Repackaged Application

In this procedure, you will distribute a Windows Installer package to a network location.

Table 10 • Distribute a Repackaged Application

<table>
<thead>
<tr>
<th>#</th>
<th>Step</th>
<th>Instructions</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>9.</td>
<td>Distribute repackaged</td>
<td>Use the Legacy Distribution Wizard to distribute the <strong>Sample Application</strong> Windows Installer package to a <strong>Network</strong> location. You open the Legacy Distribution Wizard by opening the <strong>Home</strong> tab of the ribbon, selecting the Windows Installer package node and then selecting <strong>Distribute Package</strong> from the context menu.</td>
<td><strong>SampleApplication.msi</strong> is copied to the specified network location, making it available to your enterprise.</td>
</tr>
<tr>
<td></td>
<td>application</td>
<td>For instructions on how to distribute a package to a network location, see Distributing Packages to Network Locations.</td>
<td></td>
</tr>
</tbody>
</table>

**Note** • To distribute an **application** to a System Center 2012 Configuration Manager, Citrix XenApp, Symantec Altiris, JAMF Casper Suite, or AirWatch, select the application node in the tree and then click the **Distribute** button in the ribbon. You must have already set up a named connection to that distribution system on the **Options** dialog box.

**Note** • You can publish applications containing App-V 4.x packages and Citrix XenApp profiles to Citrix XenApp server, and can publish applications containing Windows Installer, Symantec Workspace, VMware ThinApp, or legacy installers to Symantec Altiris server.

*If an application contains a package of an unsupported deployment type, that package will be ignored.*
Migrating to Application Virtualization

The flowchart on the **Migrate to Application Virtualization** tab of the AdminStudio Start page lists the steps you need to perform to migrate your application portfolio into virtual applications that are ready for deployment within the enterprise.

![Figure 7: Migrate to Application Virtualization Tab of AdminStudio Start Page](image-url)

In this section, you will use the Automated Application Converter to convert Windows Installer packages to virtual packages, and then test and distribute the virtual packages.

To migrate your application portfolio into virtual applications, perform the following steps:

- **Identifying Packages to Virtualize**
- **Converting to Virtual Formats**
- **Testing and Distributing Converted Packages**
Identifying Packages to Virtualize

In this procedure, you will import packages into the Application Catalog and identify the packages you want to virtualize.

Table 11 • Identify Packages to Virtualize

<table>
<thead>
<tr>
<th>#</th>
<th>Step</th>
<th>Instructions</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Import packages into Application Catalog.</td>
<td>Open Application Manager and locate the packages that you imported in Importing Packages into the Application Catalog.</td>
<td>The four Windows Installer packages are listed in the Application Manager tree:</td>
</tr>
</tbody>
</table>

![Application Manager tree](image_url)
2. **View package's Application Virtualization Compatibility test results.**

To view application virtualization compatibility test results, open the **Analyze** tab, and then select a group in the tree to open the **Analyze Group View**.

The packages' application virtualization compatibility test results are listed in both chart and list view. The following is the chart view:

![Chart view of application virtualization compatibility results](chart.png)

Test results are also shown in the **Application Virtualization Compatibility** column under **Supportability Risks** on the **Analyze Group View**.

![Supportability risks chart](supportability.png)

You can switch between chart and list view of clicking the toggle button in the top right corner of the view.
Table 11 • Identify Packages to Virtualize

<table>
<thead>
<tr>
<th>#</th>
<th>Step</th>
<th>Instructions</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.</td>
<td>Identify candidates for virtualization.</td>
<td>You will notice that in the Application Virtualization Compatibility column, two of the packages have a Ready status (Sample Application Source and Sample Application Target), while the other has an Error status (Sample Kit). Therefore, for the package with the error status, select the deployment type icon in the tree to open the Summary view, and then click on the error status icon under Application Virtualization Compatibility next to the unsupported virtualization type.</td>
<td>This Summary view lists the virtualization formats that generated the error:</td>
</tr>
</tbody>
</table>

---

Converting to Virtual Formats

In this procedure, you will use Automated Application Converter to convert Windows Installer packages to App-V packages.

Table 12 • Convert to Virtual Formats

<table>
<thead>
<tr>
<th>#</th>
<th>Step</th>
<th>Instructions</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.</td>
<td>Import candidate packages into Automated Application Converter.</td>
<td>Open Automated Application Converter, open the existing project you created in Configuring a Virtual Machine, and use the Package Import Wizard to add the packages that you identified in Identifying Packages to Virtualize.</td>
<td>Packages are listed on the Packages tab.</td>
</tr>
</tbody>
</table>

Note • For instructions, see Selecting Packages from an AdminStudio Application Catalog.
### Table 12 • Convert to Virtual Formats

<table>
<thead>
<tr>
<th>#</th>
<th>Step</th>
<th>Instructions</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>5.</td>
<td>Convert to virtual packages.</td>
<td>First, open the <strong>Project Options</strong> dialog box and make sure that the <strong>Package Creation</strong> property is set to <strong>App-V 4.6 with AdminStudio</strong>. Then, use the Application Conversion Wizard to convert the packages to App-V 4.x applications.</td>
<td>When conversion is complete, each virtual package is listed in a tree structure under its original package on the Packages tab.</td>
</tr>
<tr>
<td>6.</td>
<td>Test launch virtual packages.</td>
<td>Test the virtual packages by launching them on a virtual machine.</td>
<td>Virtual packages launch successfully.</td>
</tr>
<tr>
<td>7.</td>
<td>Publish virtual packages to Application Catalog.</td>
<td>Import the new virtual packages into the Application Catalog.</td>
<td>The virtual packages are listed in the Application Manager tree under their associated Application.</td>
</tr>
</tbody>
</table>

**Note** • For instructions, see Performing a Conversion Using the Application Conversion Wizard.

**Important** • Make sure that you have already performed the steps in Configuring a Virtual Machine before beginning this step.

**Note** • For instructions, see Performing Automated Testing of App-V Packages.

**Note** • You may need to click Ctrl + R to refresh the Application Catalog tree.
Testing and Distributing Converted Packages

In this procedure, you will validate the converted packages, perform conflict analysis against other packages, resolve any issues found, and distribute the packages.

Table 13 • Test and Distribute Converted Packages

<table>
<thead>
<tr>
<th>#</th>
<th>Step</th>
<th>Instructions</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>8.</td>
<td>Perform virtualization best practices testing.</td>
<td>By default, App-V best practices testing is performed during import (as described in Import Options). To perform this testing manually, first select the Analyze tab in the Application Manager ribbon. Then, select one of the App-V packages in the Application Manager tree, and click Execute Tests. Messages appear in the Output Window.</td>
<td>When testing is complete, results are displayed on the Summary tab of the Analyze Deployment Type View.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Note • For more information, see Performing Compatibility, Best Practices, and Risk Assessment Testing.</td>
<td></td>
</tr>
<tr>
<td>9.</td>
<td>Perform conflict testing.</td>
<td>In Application Manager, perform conflict testing of the Sample Application Source App-V package against the Sample Application Target App-V package.</td>
<td>Conflict analysis results are listed in the Output window and in the Conflicts view. An error is detected: Package ‘Sample Application Source’ has a conflicting root Directory ‘SampleAp.100’ with package ‘Sample Application Target’.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Note • For instructions, see Testing for Conflicts Between Packages.</td>
<td></td>
</tr>
<tr>
<td>10.</td>
<td>Edit App-V packages (if necessary).</td>
<td>To resolve the error that was found during testing on Sample Application Source App-V package, select it on the Home tab of the Application Manager tree and select Edit with Virtual Package Editor. In the Virtual Package Editor’s General Information view, change the Root Folder Name property to SampleAp.200 and click Save.</td>
<td>The edited App-V package is imported into the Application Catalog. Note • When you rerun the conflict testing that you ran in the previous step, no error will be generated.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Note • For instructions, see Using the Virtual Package Editor.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Return to Application Manager and reimport the edited package.</td>
<td></td>
</tr>
</tbody>
</table>
Testing for Application Compatibility

The flowchart on the **Test for Application Compatibility** tab of the AdminStudio Start page outlines how to use Application Manager to test packages for compatibility with the latest versions of Windows and Windows Server operating systems, as well as to test web applications for compatibility with Internet Explorer 11 and Microsoft Edge.

**Figure 8:** Test for Application Compatibility Tab of AdminStudio Start Page

In this section, you will test some packages for operating system compatibility fix issues that were found. You will also test web applications, both statically and dynamically.

To perform application compatibility testing, perform the following steps:

---

**Table 13 • Test and Distribute Converted Packages**

<table>
<thead>
<tr>
<th>#</th>
<th>Step</th>
<th>Instructions</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>11</td>
<td>11. Distribute to enterprise for user acceptance testing and production.</td>
<td>Distribute this tested App-V package to a <strong>Network</strong> location.</td>
<td>The selected App-V package is copied to the specified network location, making it available to your enterprise.</td>
</tr>
</tbody>
</table>

**Note** • For instructions on how to distribute a package, see *Distributing Packages to Network Locations*.

**Tip** • Distribution Wizard also supports deploying applications to System Center Configuration Manager (Current Branch), System Center 2012 Configuration Manager, System Center 2007 Configuration Manager, Citrix XenApp Server, JAMF Casper Suite, AirWatch Server, Microsoft App-V Server, and Symantec Altiris distribution systems. For more information, see *Distributing Applications*.  

---

In this section, you will test some packages for operating system compatibility fix issues that were found. You will also test web applications, both statically and dynamically.

To perform application compatibility testing, perform the following steps:
Importing Packages, Web Applications, and Mobile Apps

In this procedure, you will load the packages to test and select the reports to run.

Table 14 • Importing Packages and Web Applications

<table>
<thead>
<tr>
<th>#</th>
<th>Step</th>
<th>Instructions</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Import Windows Installer packages into Application Catalog.</td>
<td>For this exercise, we will test Windows Installer packages that were imported into the Application Catalog earlier in this guide in Importing Packages into the Application Catalog.</td>
<td>The Application Manager tree should now be organized as follows:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Note • For instructions on how to import a directory of packages into the Application Catalog, see Importing a Folder of Multiple Packages.</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Import web applications into Application Catalog.</td>
<td>First, open the Import Options &gt; General tab of the Application Manager Options dialog box, and clear the selection of the Automatically Execute Tests After Import option.</td>
<td>The web applications are listed in the Application Manager tree:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Next, create a new group in the Application Manager tree named Web Applications.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Then import the following web applications into the Web Applications folder, as described in Importing a Deployed Web Applications.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Orbitz at: <a href="http://www.orbitz.com">http://www.orbitz.com</a></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Travelocity at: <a href="http://www.travelocity.com">http://www.travelocity.com</a></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Because these web applications do not require a login to access, leave the User name and Password fields on the Web Site Details panel blank.</td>
<td></td>
</tr>
</tbody>
</table>
Selecting Tests to Run and Setting Default Fix Option

In this procedure, you will select the Operating System Compatibility and Browser Compatibility tests to run and set default fix options.

Table 15 • Selecting Tests to Run and Setting Default Fix Option

<table>
<thead>
<tr>
<th>#</th>
<th>Step</th>
<th>Instructions</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.</td>
<td>Select the operating system and browser compatibility tests that you want to run.</td>
<td>Select the Operating System Compatibility and Browser Compatibility tests that you want to run, as described in Selecting Tests to Execute.</td>
<td>The Operating System Compatibility and Browser Compatibility tests that you want to run are selected on the Select Tests to Execute dialog box.</td>
</tr>
</tbody>
</table>

**Tip** • To speed up testing, it is recommended that you select just the operating systems and browser versions that are being used in your organization.
Performing Testing and Viewing Results

In this procedure, you will test packages and web applications for operating system and browser compatibility, view test results, and automatically fix issues.

Table 15 • Selecting Tests to Run and Setting Default Fix Option

<table>
<thead>
<tr>
<th>#</th>
<th>Step</th>
<th>Instructions</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>5.</td>
<td>Set the default fix option for selected tests: basic fix, advanced fix, or do not fix.</td>
<td>Some of the tests in the Operating System Compatibility and Browser Compatibility test group let you specify whether to perform a basic or advanced fix when you automatically resolve issues, as described in Setting Automatic Fix Preferences for Operating System Compatibility and Browser Compatibility Tests. On the Select Tests to Execute dialog box, review the Default Fix section of several of your selected tests. For this exercise, it is not necessary to make any changes to the Default Fix settings.</td>
<td>A Default Fix selection is made for all Operating System Compatibility and Browser Compatibility tests.</td>
</tr>
</tbody>
</table>

5. Click Execute Tests to test Windows Installer packages, mobile apps, and web applications (statically).

First select the Analyze tab in the Application Manager ribbon

Then, select the Applications group in the Application Manager tree, and click Execute Tests.

Messages are listed in the Output Window. When testing is complete, the following message is displayed:

Tested 6 packages of 6.

Note • For more information, see Performing Compatibility, Best Practices, and Risk Assessment Testing.
To interactively, dynamically test a web application, select a web application node in the tree and click **Launch Web Test**.

---

**Note** • For more information, see *Performing Dynamic Testing of Web Applications.*

Application Manager launches the web application in your browser. Then, as you perform tasks and navigate around the web application, Application Manager records any warnings or errors that are encountered while using that version of the browser.

When you have finished testing, close the browser window.

---

**Tip** • You should always use dynamic testing when a web application requires a login to access.

---

**Tip** • As each page loads, Application Manager begins testing. Links on each page do not become active until testing is complete on that page, so you may have to wait several seconds before proceeding.
### Table 16 • Performing Testing and Viewing Results

<table>
<thead>
<tr>
<th>#</th>
<th>Step</th>
<th>Instructions</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>8</td>
<td>View test results.</td>
<td>When testing is finished, view the test results by selecting a Windows Installer package or web application in the tree to open the <strong>Summary</strong> view of the <strong>Supportability Risks</strong> of the <strong>Analyze Deployment Type View</strong>.</td>
<td></td>
</tr>
</tbody>
</table>

Click an icon in the Overall Assessment column to view detailed test results:

- **Click the Suppress (ON/OFF) button** to suppress any issues that are not important to your organization.

**Note** • For more information, see *Viewing Operating System Compatibility Test Results* and *Viewing Browser Compatibility Test Results*.
Click Resolve Issues to automatically resolve issues.

Issues for which automatic fixes are available are identified by the Error With Fix or Warning With Fix icon:

To automatically resolve all issues for which automatic fixes are available, select the Applications group node in the tree and click Resolve Issues in the Analyze tab of the ribbon.

Note • For more information, see Performing Automatic Issue Resolution.

Issue resolution begins, progress messages appear in the Output window, and Application Manager performs the following tasks:

- **Reruns tests**—Application Manager reruns all of the selected tests to ensure that the issues that it is going to resolve still exist in the current version of the package and its associated transforms.
- **Creates transform files**—To resolve issues, Application Manager generates fix transform files.
- **Reimports packages**—Application Manager then automatically reimports each package and its fix transform files into the Application Catalog.

When issue resolution and reimporting is complete, look at the Analyze Group View, Application View, or Deployment Type View of the package, application, or group that you tested. You will see that the Error With Fix and Warning With Fix icons have been replaced with the status icon with the next highest level (as described in the Hierarchical Level of Status Icons section of the About Status Icons help topic) in that test category.